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1. Introduction

Welcome to OMERO

This document provides a comprehensive guide to the Beta version of the OMERO.importer
and OMERO.insight. These applications together allow you to import your microscopy
images into the OMERO system, and manage, manipulate and view them.

The software was released for general use in June 2007.

This guide includes the following sections:

• Section 2 - Getting started with OMERO. Installing the software, and a brief guide to
importing images using OMERO.importer and performing basic image management,
viewing and manipulation tasks using OMERO.insight.

• Section 3 - Advanced OMERO. More details on using OMERO.insight.
• Section 4 - Help and feedback. How you can provide the development team with

feedback to influence future development.
• Section 5 - Background information. The concepts and models behind the OMERO

suite of software.

Enjoy using the software!

The OMERO development team, University of Dundee, UK.
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2. Getting started with OMERO

This section provides you with the essential information you need to perform key tasks using
OMERO:

• Installing the software;
• Logging in;
• Importing images;
• Viewing single/multiple image(s);
• Annotating images;
• Saving images.

More advanced tasks are described in .

2.1.Installing OMERO.importer and OMERO.insight
2.2.Logging in
2.3.Importing images
2.4.Viewing images
2.4.1.Viewing a single image
2.4.1.1.Viewing z-sections or timepoints
2.4.1.2.Adjusting channels
2.4.1.3.Additional viewing options
2.4.2.Viewing a selection of images: the Hierarchy Viewer
2.5.Saving images
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2.1. Installing OMERO.importer and OMERO.insight

Latest versions of OMERO.importer and OMERO.insight are available for download from:
http://trac.openmicroscopy.org.uk/omero/wiki/MilestoneDownloads

Once you have downloaded the OMERO.importer and OMERO.insight installer packages,
double-click the packages to start the install process.
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2.2. Logging in

The log-in procedure is the same for OMERO.importer and OMERO.insight.

When you start OMERO.importer, you will be asked to log in (See Figure 2.2-1). The
administrator who set up OMERO can provide you with a user account and the address of
the OMERO.server where your images will be stored.

You provide the address of the OMERO server by selecting the button and entering the

details in the form provided.

Figure 2.2-1 : Log in screens for OMERO.importer and OMERO.insight

Once logged in successfully, the appropriate OMERO application will open up.
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2.3. Importing images

OMERO currently allows you to import the following file formats:

• Bio-Rad PIC (*.pic)

Excluding

• multi-plane "stitched" files;
• annotated ROI images.

• Bitmap (*.bmp)

Excluding

• Compressed images;
• Mutli-plane Color images.

• Deltavision (*.dv, *.r3d, *.r3d_d3d)
• Digital Imaging and Communications in Medicine (*.dcm, *.dicom, *.dic)

Excluding

• Compressed images.

• Graphics Interchange Format (*.gif)
• Imaris Raw Images (*.ims): 5.0 format and 5.5 format.
• Improvision Tiff (*.tif)
• Joint Photographic Experts Group (*.jpeg, *.jpg)

Excluding

• JPEG2000 images.

• Leica "lei" Format (*.lei)
• Leica Image Format (*.lif)
• Metamorph STK (*.stk)
• Openlab Raw (*.raw)
• Openlab LIFF (*.liff)
• Portable Gray Map (*.pgm)
• Portable Network Graphic (*.png)
• Tagged Image File Format (*.tif, *.tiff)
• Visitech XYS (*.xys)
• Zeiss Laser-Scanning Microscopy (*.lsm)
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NB: Tagged Image File Format

This is a very open standard, so expect a few variant types to be unsupported. We do however do extensive tiff
testing so the format is generally well supported.

NB: Visitech XYS

The Visitech importer does not fully support all Visitech metadata included in the accompanying html file.

NB

Since the following formats: bmp, gif, jpeg, pgm, png, tiff, do not contain metadata, the importer will use default
values for the pixel size and channel meta data.

You can use OMERO.importer to select images from a storage disk and import them into the
OMERO system.

Figure 2.3-1 : OMERO.importer in File Viewer mode
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Figure 2.3-2 : import window, showing images destination and filename options

To import images into OMERO:

1. Log into OMERO.importer. The application will open a window similar to that shown in
Figure 2.3-1 .

2. Use the File Viewer panel to browse and select one or more images you would like to
import.

3. Add the selected images to the list of images for importing (referred to as the Import
Queue ) by selecting the plus button:

4. The import window appears - see Figure 2.3-2 , prompting you to select a Project and
Dataset - this will be the destination on the OMERO.server for the imported images. In
this window you can:

a. Select an existing Project and Dataset from the menus shown, if you have
previously created them in either OMERO.importer or OMERO.insight.

b. Or, for first-time OMERO users, use the Add button to create a new Project. You
can then create a new Dataset in your new Project, or a new Dataset in an existing
Project.

c. The bottom half of the import window (see Figure 2.3-2 ) also allows you to select a
filename from one of three options:

i. the "short" file name e.g. "myImage.dv",
ii. the full path name e.g "c: important_work/stuff/myImage.dv",
iii. the short file name plus a number of leading directories, e.g. if you choose to

add one directory to the directory "c:important_work/stuff/myImage.dv", your
final imported image would be named "stuff/myImage.dv".
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d. You can also choose to import a copy of the image file in its original format.

5. You can continue to select more images to add to the Import Queue, by following steps
2-4 above.

6. Once you have finished selecting images, select the Import button at the bottom right
hand corner of the window. The import process will now start. You can view the progress
in the Status column of the Import Queue window. You may also add additional images
to the import queue while an import is already running. This will only add the images to a
new queue - when you are ready to import these new images, click the import button
again to begin importing them.

7. When all selected images have status of "done", your images have been successfully
imported, and you can then move to OMERO.insight to start working with your images.

OMERO.importer has two additional options to File Viewer mode:

• The Output Text mode: clicking on the Output Text tab shows you a brief list of the
current import status as files are being imported.

• The Debug Text mode: clicking on the Debug Text tab shows you more technical
information about the import status as files are being imported.
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2.4. Viewing images

Once you have imported some images using OMERO.importer, open OMERO.insight to view
them either individually or as a selection of thumbnails.

When you first log in to OMERO.insight, you will see the image filenames listed under the
relevant Project and Dataset in OMERO.insight's Data Manager (see Figure 2.4-1 ).

See Section 3.1 for a fuller description of the Data Manager.

Figure 2.4-1 : Data Manager Window, showing images stored in OMERO

2.4.1.Viewing a single image
2.4.1.1.Viewing z-sections or timepoints
2.4.1.2.Adjusting channels
2.4.1.3.Additional viewing options
2.4.2.Viewing a selection of images: the Hierarchy Viewer
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2.4.1. Viewing a single image

To view an image:

• Either double-click on the image filename,
• Or select the image filename, and then select the View Image button .

In either case the image will be displayed in a new window - the Image Viewer window. The
Image Viewer allows you to view your image in three different ways:

• Standard Image View (see Figure 2.4.1-1 ).
• Annotation View: reduced size image with details of annotations shown (see Figure

2.4.1-2 ).
• Split View: showing each channel as a separate image (for multi-channel images), plus

composite image, side-by-side (see Figure 2.4.1-3 ).

You can view more than one image at the same time -each will open in a separate Image
Viewer window.

Figure 2.4.1-1 : Image Viewer, Standard
View

Figure 2.4.1-2 : Image Viewer, Annotation
View
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Figure 2.4.1-3 : Image Viewer, Split View

2.4.1.1.Viewing z-sections or timepoints
2.4.1.2.Adjusting channels
2.4.1.3.Additional viewing options
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2.4.1.1. Viewing z-sections or timepoints

For images with multiple z-sections or timepoints, OMERO allows you to easily view these
manually or automatically.

To manually view composite z-sections or timepoints for an image in the Image Viewer
window (all three views):

• Use the vertical Z slider to manually view individual z-sections.
• Use the horizontal T slider to manually view individual timepoints.

Or, open the Controls menu and select the Movie option to open the Movie Player. Here
you can play all z-sections or timepoints in sequence, as a movie.

Alternatively, Holding down the mouse button and dragging the mouse vertically up or down
the image moves through z-sections; dragging horizontally moves through timepoints.
Dragging diagonally will simultaneously change z-sections and timepoints.

For more details on viewing z-sections and timepoints using the Movie Player, see Section
3.9.4.
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2.4.1.2. Adjusting channels

To adjust channels for multi-channel images, in the Image Viewer (Standard View or Split
View):

• Use the colour buttons on the left-hand side of the image to turn on or off a colour
channel.

• Switch between colour and greyscale representations of the image by going into the
Controls menu, selecting Models , and choosing Colour or Greyscale .

For more details on adjusting channels, see Section 3.9
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2.4.1.3. Additional viewing options

The Image Viewer provides a number of additional tools:

• Adjust the image properties using the Rendering Tool (see Section 3.9.3.5).
• Magnify an image or area of interest within the image (see Section 3.9.3).
• View in greyscale; or view additional information about the image (see Section 3.9.2).
• Configure the optional scale bar (see Section 3.9.3.3).
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2.4.2. Viewing a selection of images: the Hierarchy Viewer

A selection of images for viewing can be made at different levels, based on how your data is
organised in OMERO. You can:

• Select one or more projects - this selects all images in each dataset belonging to the
selected project(s) groups.

• Select one or more datasets - this selects all images in the selected datasets.
• Select one or more images, by using the keyboard and/or mouse to select more than

one image filename from the list shown in the left-hand pane.

NB

You can also select images according to the Category they belong to, which is another way of organising your
data - you define your own category groups and categories, and then you can place your images into one or more
categories. For more on categories, see Section 3.7.

To view a selection of images:

1. In the Data Manager, select the first project, dataset, category group, category or image
you wish to view by clicking once to highlight it.

2. Use the appropriate keys for your operating system to select subsequent projects,
datasets, category groups, categories or images.

NB

You can only select multiple objects of the same level - for example you can select 5 images, but not one dataset
plus 5 images. However, you can select individual datasets from different projects if desired.

3. Once you have your selection, select the Browse button . This brings up a Hierarchy

Viewer window showing a series of thumbnails, one for each image in your selection
(see Figure 2.4.2-1 ).
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Figure 2.4.2-1 : Hierarchy Viewer, showing simple selection of images

The Hierarchy Viewer also provides:

• a range of tools for viewing individual thumbnails;
• options to rearrange the display of thumbnails;
• facilities to display and edit information relating to a particular thumbnail.

See Section 3.10.2 for more details.
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2.5. Saving images

You can save a copy of any image displayed in the Image Viewer, in a number of different
image formats. This may be particularly useful for having a copy to include in a presentation
or publication.

1. Open the Controls menu and select the Save As option. Or, select the icon in the

Image Viewer .
2. In the Save Image window you can:

a. Specify the name of the saved image file.
b. Select the destination of the saved image file (this can be set to be the default folder

for future save operations).
c. Select the saved image file format from a choice of BMP, JPEG, TIFF or PNG.
d. Choose the type of image to save - in the Images menu, select from:

• A simple image;
• Image and split channels in grid form;
• Image and split channels in a row;
• Image and split channels in a row, in grey;
• Lens image;
• Lens image and split channels;
• Lens image and split channels in grey.

3. You will see a preview of the image to be saved before you confirm the save action.
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3. Advanced OMERO

This section provides more in-depth information on the tasks OMERO.insight supports.

3.1.Getting to know the Data Manager
3.2.Viewing and editing user account details
3.3.Managing projects and datasets
3.3.1.Creating projects and datasets
3.3.2.Renaming projects or datasets
3.3.3.Removing projects or datasets
3.3.4.Expanding a project to see constituent datasets
3.3.5.Expanding a dataset to see constituent images
3.3.6.The Projects, Categories and Images tabs
3.4.Viewing other people's images
3.5.Additional information about projects, datasets and images
3.6.Annotations
3.6.1.Viewing annotations
3.6.2.Annotating a single image or dataset
3.6.3.Annotating multiple images or datasets
3.7.Categorising images
3.7.1.Creating category groups
3.7.2.Creating categories
3.7.3.Removing categories and category groups
3.7.4.Categorising images
3.7.4.1.Categorising a single image
3.7.4.2.Categorising multiple images
3.7.4.3.Viewing images in a category
3.7.4.4.Removing an image from a category
3.8.Sorting and finding images
3.8.1.Sorting images
3.8.2.Retrieving selected images
3.8.3.Finding images with Find in Tree
3.9.Viewing images
3.9.1.Viewing a specific Channel
3.9.2.Additional viewing options
3.9.2.1.Colour and greyscale viewing
3.9.2.2.Movie viewing across channels
3.9.2.3.Channel configuration
3.9.2.4.Image information
3.9.2.5.Annotation View
3.9.3.Magnification
3.9.3.1.Magnifying the whole image
3.9.3.2.Magnifying an area of the image
3.9.3.3.Scale bar
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3.9.4.Viewing z-sections and timepoints
3.9.4.1.Automated viewing of z-sections and timepoints
3.9.4.2.Selecting z-section and timepoints
3.9.4.3.Additional Movie Player options for z-section and timepoint viewing
3.9.5.Image Rendering options
3.10.Introduction to the Measurement Tool
3.10.1.Accessing the Measurement Tool
3.10.2.The Measurement Tool interface
3.10.3.Creating ROIs
3.10.3.1.What is an ROI?
3.10.3.2.Creating a single shape
3.10.3.3.Adding multiple ROI shapes on one plane
3.10.3.4.Creating an ROI across z-sections and timepoints
3.10.4.Saving and loading ROIs
3.10.4.1.Saving ROIs
3.10.4.2.Loading ROIs
3.10.5.Editing ROIs
3.10.5.1.Selecting ROIs
3.10.5.2.Annotation and labelling
3.10.5.2.1.Annotating an existing ROI shape
3.10.5.2.2.Labelling Images
3.10.5.3.Moving or resizing a single ROI
3.10.5.3.1.Moving a single ROI shape
3.10.5.3.2.Resizing a single ROI shape
3.10.5.4.Changing the appearance of an ROI shape
3.10.5.4.1.Adjusting display of annotation text
3.10.5.4.2.Adjusting display of the ROI shape
3.10.5.4.3.Hiding ROI shapes
3.10.5.5.Deleting a single ROI shape
3.10.5.6.Editing multiple ROI shapes and ROIs
3.10.6.Viewing ROI information
3.10.6.1.Viewing summary ROI information
3.10.6.2.Measurement results
3.10.6.2.1.Showing summary results
3.10.6.2.2.Refreshing summary data
3.10.6.2.3.Saving summary data
3.10.6.3.Viewing pixel intensity values
3.10.6.3.1.Graphical view
3.10.6.3.1.1.Configuring the Graph view
3.10.6.3.1.2.Saving graphical views
3.10.6.3.2.Intensity View
3.11.The Hierarchy Viewer: viewing multiple images
3.11.1.Viewing an image from the Hierarchy Viewer
3.11.2.Using the Hierarchy Viewer
3.11.2.1.Adjusting thumbnail display
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3.11.2.2.Display Tree View of images
3.11.2.3.Sorting images
3.11.2.4.Managing images in the Hierarchy Viewer
3.11.2.5.Additional image information: the Working Area
3.12.Managing windows in OMERO.insight
3.13.Closing OMERO.insight
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3.1. Getting to know the Data Manager

Every time you log in OMERO.insight, you will see Data Manager's default screen, which
consists of several areas of interest as labelled in Figure 3.1-1 .

1. The left-hand pane shows projects and datasets, category groups, categories or images
in a hierarchical manner. (Note that on first accessing OMERO.insight, this pane will be
empty until you create a project.)

2. The right-hand pane shows information relating to the currently selected project, dataset,
category group, category or image; and will be blank if none exists or none is selected.

3. Above the two panes are three distinct navigational areas. From the top of the page,
these are:

a. Application-wide toolbar. This gives access to options that remain constant
throughout use of the Data Manager.

b. The Projects , Categories and Images tabs. These specify what information is
shown in the left-hand pane.

c. Context-specific toolbar. This provides options specific to whether Projects and
Datasets, Category Groups and Categories, or Images are being shown in the
left-hand pane.

4. Finally, there are five application menus, each offering options based on the current
status of OMERO.insight. The menus available are File , Edit , View , Window and
Help .
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Figure 3.1-1 : Data Manager, default screen with three projects listed

NB

If you wish to send a comment to the OMERO development team, open the Help menu and select Send
Comment .
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3.2. Viewing and editing user account details

You can make a limited amount of changes to your OMERO account details in the Data
Manager.

At the top of the tree in the left-hand pane of the Data Manager is your own user name. Click
on this to see your user account details, shown in the right-hand pane (see Figure 3.2-1 ).
There are two tabs:

• My Profile shows basic personal information.
• My Servers shows all OMERO servers for which you have a user account.

Figure 3.2-1 : User Profile Editor

NB

The only edits you can make at present is to change your OMERO password using the form here. Future releases
of OMERO will allow you to make additional changes to your account, which currently can only be made by users
with OMERO administrator status. The ability to change from one server to another will also be added in future
versions.
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3.3. Managing projects and datasets

In Section 2.3 we explained how to create projects and datasets as part of the Import
process; OMERO.insight also allows you to create and manage projects and datasets.

The following icons are used in OMERO.insight:

• denotes a project.

• denotes a dataset.

• denotes an image.

3.3.1.Creating projects and datasets
3.3.2.Renaming projects or datasets
3.3.3.Removing projects or datasets
3.3.4.Expanding a project to see constituent datasets
3.3.5.Expanding a dataset to see constituent images
3.3.6.The Projects, Categories and Images tabs
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3.3.1. Creating projects and datasets

To create a project in OMERO.insight:

1. In the File menu, select Create New project . Or, select the icon.

2. In the window that appears (see Figure 3.3.1-1), enter the name of the new project. You
can optionally add a textual description of the project.

3. Select Save to confirm.
4. Your project should now be created (Figure 3.3.1-2 shows a new project created and

named DemoProject).

Figure 3.3.1-1 : Insight's 'Add a new project' window
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Figure 3.3.1-2 : Data Manager showing details of a selected project

To create a dataset in OMERO.insight:

1. Select the project in which you want to create the dataset. The right-hand pane now
shows information about the selected project (see Figure 3.3.1-3).

2. From the File menu, select Add New Dataset . Or, select the icon.

3. In the window that appears, enter the name of the new dataset, and a textual description
if you wish.

4. Select Save to confirm the addition.
5. The dataset should now be listed in the left-hand pane, under the relevant project (see

Figure 3.3.1-4).
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Figure 3.3.1-3 : Adding a new dataset to an existing project
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Figure 3.3.1-4 : Data Manager showing one available project, containing one dataset
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3.3.2. Renaming projects or datasets

To rename a project or dataset:

1. Select the project or dataset.
2. In the right-hand pane, edit the text in the Name field.
3. Select Save to confirm changes.
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3.3.3. Removing projects or datasets

To remove a project or dataset:

1. In the left-hand pane of the Data Manager, select the project or dataset to be removed.
2. In the Edit menu, select Remove (or Remove from current project for a dataset). This

removes the selected project or dataset. 'Orphaned Datasets' will be created to hold the
removed dataset(s).

3. The removed projects or datasets will go to 'Orphaned Datasets', which appears on top
of the tree view. The number in the bracket shows how many removed datasets are in.

NB

When you remove a project, the dataset(s) in it will be listed in the 'Orphaned Datasets' and therefore you will not
see the name of the project but only the dataset(s). A project or dataset is only removed from a project - it is not
deleted from the system.
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3.3.4. Expanding a project to see constituent datasets

In the left-hand pane you might see projects listed but not their datasets (Figure 3.3.4-1). The
number in square brackets after the project name is the number of datasets belonging to the
project.

To see all datasets belonging to a project, click the Expand icon: .

All datasets associated with the selected project will now be shown (Figure 3.3.4-2). This icon
will change appearance to to show that the project has been expanded to show datasets -

clicking the icon again will collapse the display to show just the project again. Note that in
Figure 3.3.4-1, the AnotherDemoProject image has no datasets - so cannot be expanded.

Figure 3.3.4-1 : Project listing without
datasets

Figure 3.3.4-2 : Project expanded to show
datasets
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3.3.5. Expanding a dataset to see constituent images

The number in brackets after a dataset name is the number of images belonging to that
dataset.

To see all images belonging to a dataset, click the Expand icon as above - the images will
now be listed (Figure 3.3.5-1).

Figure 3.3.5-1 : Expanded dataset showing images

NB

The file path name shown, in particular the number of directories preceding the filename, reflects the settings
specified when importing using OMERO.importer. See Section 2.3 for choosing display options for lists of image
filenames.
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3.3.6. The Projects, Categories and Images tabs

You will see that in Figure 3.3.5-1, above the left-hand pane there are two tabs - Projects
and Categories visible, plus an arrow tab .

There should in fact be three tabs - the hidden one is the Images tab. If you only see two
tabs, clicking on this tab gives you a menu showing all three options, allowing you to select
the Images tab. Alternatively, hold down the mouse pointer in the space between the left and
right-hand panes, and drag to the right to widen the left-hand pane until all three tabs appear
(as in Figure 3.3.6-1).

NB

The arrow tab is reversed when only the Categories and Images tabs are shown: . In this case, click

the tab to access the Projects tab.

The Images tab is discussed further in Section 3.7, and the Categories tab is discussed further in Section 3.8.

Figure 2.3.6-1 : Expanded left-hand pane showing three tabs
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3.4. Viewing other people's images

OMERO supports collaborative work by allowing users to share images among group users.
Assuming the appropriate permissions have been granted by the image owner, it will be
possible for

• You to select another user and view their images;
• Other people with an OMERO account to view your images for which you have enabled

permission for others to view.

To select another user, view, and - if desired - annotate their images:

• Click on the Switch user icon . Or, open the File menu and select Switch user ;

• Choose the OMERO group in which the user belongs;
• Select the user from the menu that appears (see Figure 3.4-1), and select Apply .

The user's data will appear in a new Data Manager window.

Figure 2.4-1 : Switch User selection menu
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3.5. Additional information about projects, datasets and images

You can view additional information to a selected project, dataset or image. This is available
in the right hand pane of the Data Manager:

• The Properties tab shows you the name and description of the selected project, dataset
or image. In future versions of OMERO.insight, you will be able to set permission levels
for accessing the selected project, dataset or image (see Figure 3.5-1).

• The Annotations tab allows you to see and add annotations to the selected dataset or
image. You cannot add an annotation to a project. For more on Annotations, see Section
3.6.

• The Info tab is available when an image is selected. This provides information about the
image, including X, Y dimensions, number of z-sections and timepoints, pixel sizes and
number of emission wavelengths.

Figure 3.5-1 : Viewing permissions information for a selected image
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3.6. Annotations

OMERO lets you add annotations - textual notes - to any image or dataset in your collection.
You can also add annotations to any other images that you have permission to see.

3.6.1.Viewing annotations
3.6.2.Annotating a single image or dataset
3.6.3.Annotating multiple images or datasets
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3.6.1. Viewing annotations

The icon shows that a dataset has one or more annotation (see TestDataset1 in Figure

3.3.4-1 for an example).

The icon shows that an image has one or more annotations.

To view annotations in the Data Manager:

1. Select the image or dataset for which you wish to see the annotations.
2. Select the Annotation tab in the right-hand pane.
3. A window appears with two panes (see Figure 3.6.2-1):

• The left-hand pane shows a tree-list of all annotations for the selected image,
dataset or project, plus date and time the annotation was made. Annotations are
grouped by users, allowing you to see any annotations made by other users.

• The right-hand pane provides an area for you to add a new annotation; it also shows
the content of all existing annotations.

You can also view an image's annotation(s) in the Image Viewer - see Section 2.4.1, or in the
Hierarchy Viewer - see Section 3.10.
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3.6.2. Annotating a single image or dataset

To add a new annotation to a selected image or dataset:

1. Making sure the Annotation tab is selected, type in a new annotation in the right-hand
pane.

2. On completing the annotation, select the Save button to confirm.

On saving, the annotation will be 'stamped' with the user who created the annotation, and the
time the annotation was created.

Figure 2.6.2-1 : Adding an annotation to an image

You can also add an annotation to an image in the Image Viewer - see Section 3.9.2.5, and
in the Hierarchy Viewer - see Section 3.10.2.5.
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3.6.3. Annotating multiple images or datasets

OMERO allows you to add an annotation to a selection of images or datasets, all at once.

To do this,

1. Select the images or datasets.
2. Select the toolbar icon .

3. This opens up the Annotate dialog box (see Figure 3.6.3-1). It shows you, in three
panes:

a. the list of images or datasets selected,
b. a tree view showing names of users who have added annotations; expanding a user

name shows the time of each annotation added.
c. space to add a new annotation or see the text of any existing annotation.

4. Enter the annotation text in the right hand pane.
5. Select Save ; a message box appears (see Figure 3.6.3-2). Choose the All option to

save the annotation for all selected images or datasets; or One to save the annotation
for only the first selected item - the one named in the message box.

Figure 3.6.3-1 : Annotating multiple items
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Figure 3.6.3-2 : Multiple annotation confirmation
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3.7. Categorising images

OMERO.insight allows you to create categories for use in managing your images, as a
separate means of organisation from the Project/Dataset structure. To do this, first you create
a category group, and then create one or more categories within the category group. Once
you have some Categories, you can then use these to categorise your images.

Icons used:

• denotes a category group.

• denotes a category.

• denotes a categorised image.

• denotes a categorised image that also has one or more annotations.

3.7.1.Creating category groups
3.7.2.Creating categories
3.7.3.Removing categories and category groups
3.7.4.Categorising images
3.7.4.1.Categorising a single image
3.7.4.2.Categorising multiple images
3.7.4.3.Viewing images in a category
3.7.4.4.Removing an image from a category
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3.7.1. Creating category groups

Creating a category group is a similar process to creating a Project:

1. Select the Categories tab. This will bring up a list of existing Category Groups (or will be
empty if none exist).

2. Then:

• Either click the Create Category Group toolbar button .

• Or go to the File menu, and select the New Category Group... option.

3. In the right-hand pane, enter the Category Group name, and an optional textual
description (Figure 3.7.1-1).

4. Select Save to confirm.
5. Your Category Group should now be listed in the left-hand pane.

Figure 3.7.1-1 : Adding a Category Group
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3.7.2. Creating categories

Creating a category is a similar process to creating a dataset:

1. Select the category group into which the category should go (i.e. make sure it is
highlighted in the left-hand pane).

2. Then:

• Either click the Create Category toolbar button .

• Or go to the File menu, and select the New Category... option.

3. In the right-hand pane, enter the Category name, and an optional textual description.
4. Select Save to confirm.
5. Your Category should now be listed in the left-hand pane, under the appropriate

Category Group.

Figure 3.7.2-1 shows a list of category groups with categories. The number in brackets after
each category group name indicates how many categories belong to that group; similarly the
number after each category name indicates how many images belong to that category.

Figure 3.7.2-1 : List of category groups with categories
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3.7.3. Removing categories and category groups

To remove a category from a category Group:

1. Select the category to be removed.
2. In the Edit menu, select Remove .
3. The category will be removed from the category group. 'Orphaned Categories' will be

created to hold the removed category.
4. The removed category will go to 'Orphaned Categories', which appears on top of the tree

view. The number in the bracket shows how many removed categories are in.
5. Similarly, to remove a category group, select the category group to be removed, and use

the Edit menu as above.

NB

A category or category group is only removed from a project - it is not deleted from the system.
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3.7.4. Categorising images

Once you have created one or more categories, you can categorise your images.

3.7.4.1.Categorising a single image
3.7.4.2.Categorising multiple images
3.7.4.3.Viewing images in a category
3.7.4.4.Removing an image from a category
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3.7.4.1. Categorising a single image

To categorise an individual image:

1. Select the image filename.
2. Then:

• Either in the Edit menu, select Categorise .
• Or select the toolbar button and then Categorise from the pop-up menu that

appears.

3. In the right-hand pane, you will initially see a list of available category groups. Select the
appropriate category group and expand it by selecting the Expand button .

4. Tick all categories you wish to add the selected image to. ( Select All and Deselect All
buttons are available to speed up the task of selection).

5. Select Save to confirm the categorisation.
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3.7.4.2. Categorising multiple images

If you wish to add more than one image to the same category or categories, the steps
described in Section 3.7.4.1 can be applied for multiple selected images.
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3.7.4.3. Viewing images in a category

To view all images in a selected category:

1. Select the Categories tab.
2. In the left-hand pane, expand the category group and select your chosen category.
3. The list will expand to show all images currently in that category (see Figure 3.7.4.3-1).

Figure 3.7.4.3-1 : Viewing all images in a selected category
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3.7.4.4. Removing an image from a category

To de-categorise an individual image:

1. Select the image filename.
2. Then:

• Either in the Edit menu, select Decategorise .
• Or select the toolbar button and then Decategorise from the pop-up menu that

appears.

3. In the right-hand pane, you will initially see a list of available Category Groups. Select
the appropriate category group and expand it by selecting the Expand button: .

4. Tick all categories from which you wish to remove the selected image. ( Select All and
Deselect All buttons are available to speed up the task of selection).

5. Select Save to confirm the de-categorisation.
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3.8. Sorting and finding images

As you build up collections of images, you may wish to sort them into manageable groups, or
find a specific image or group of images in your collection. OMERO.insight allows you to sort
images by various techniques, and also to search for a specific image(s).

3.8.1.Sorting images
3.8.2.Retrieving selected images
3.8.3.Finding images with Find in Tree
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3.8.1. Sorting images

A number of options are available for sorting a collection of images. These are provided in
the context-specific toolbar (labelled as 3c in Figure 3.1-1) directly below the Projects ,
Categories and Images tabs (Figure 3.8.1-1), and are available to a list of images.

Figure 3.8.1-1 : Toolbar providing sort options

These options are:

- Alphabetical sort. Select this option to sort image file names in alphabetical order. In the

illustration in Figure 3.8.1-1, this option is selected, and hence the icon appears shaded.

- Date sort. Select this option to sort image file names in order of the date they were

taken on the microscope - and if this information is not available, in order of the date of import
into OMERO.

NB

If the list of images shows more than one open dataset or category, images are sorted alphabetically or by date
only within their parent dataset or category - although the order in which datasets or categories appear may
change.

- This option allows you to toggle between showing a truncated path name and full path

name for each listed image. Figure 3.8.1-2 and Figure 3.8.1-3 show the difference in image
display names.

Figure 3.8.1-2 : Truncated image
pathname

Figure 3.8.1-3 : Full image pathname

NB

The actual number of directories shown in the full image pathname depends on the option chosen when importing
the image using OMERO.importer.
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- This option expands to reveal a menu with further options for viewing images, discussed

in more detail in Section 3.8.2. It is only visible when the Images tab is selected;

- This option allows you to quickly collapse the current list of image filenames to show

only parent projects or category groups.

NB

If at any time the left-hand display appears not to be showing the information you expect, select or Refresh

Current Tree from the File menu to refresh the display.

OMERO clients User Guide

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-53



3.8.2. Retrieving selected images

You can retrieve selected images from your collection of imported data by filtering out images
based on the categories they belong to or by datasets.

Figure 3.8.2-1 : Filter images retrieval window

Clicking the Images tab (see Section 3.3.2) results in a new window being displayed - the
Filter Images Retrieval window (Figure 3.8.2-1). This allows you to specify which image
filenames you would like to see listed in the left-hand pane. You have three choices:

1. Select images from chosen datasets.
2. Select images from chosen categories.
3. Select all images in your collections.

Select the Image menu button to see the Image menu (shown in Figure 3.8.2-2). This

allows you to specify how Filter Images Retrieval will work.

On choosing either of the first two options in the list above, the Filter Images Retrieval
allows you to select those datasets or categories from which you wish to retrieve images. All
image filenames found will then appear in the left-hand pane.
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Figure 3.8.2-2 : Menu for configuring Filter Images Retrieval
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3.8.3. Finding images with Find in Tree

The Find in Tree feature works in a similar way to the 'Find in Page' feature provided by
many Web browsers. It allows you to search for a text string within all items displayed in the
left-hand pane (Figure 3.8.3-1).

Figure 3.8.3-1 : Find in Tree request showing results

To conduct a search:

1. In the Edit menu, select Find in Tree . A form will appear at the bottom of the Data
Manager window.

2. Type the text string you wish to search for in the Find : text box.
3. Use the arrow icon to select whether you wish to find a pattern in image names or

descriptions.
4. The Match Case checkbox can be checked if you want to ensure that image filenames

are returned only if they match the case of the text string you specify.

The search will be dynamically conducted, reporting how many images were found that
match your search criteria. The first image found will be highlighted (Figure 3.8.3-1); use the
Find Next or Find Previous buttons to move through each image found. If no images are
found, a Phrase Not Found message is shown.
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NB

The Find in Tree feature can also work with datasets, projects, categories and category groups - i.e. whatever is
currently listed in the left-hand pane.
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3.9. Viewing images

In Section 2.4.1 we described how you can view an image in constituent channels, time
points or z-sections in OMERO's Image Viewer.

Section 2.4.2 described how thumbnails of a selection of images can be viewed using the
Hierarchy Viewer.

This section provides further information on viewing images using the Image Viewer.

Figure 3.9-1 : The Image Viewer, standard view

3.9.1.Viewing a specific Channel
3.9.2.Additional viewing options
3.9.2.1.Colour and greyscale viewing
3.9.2.2.Movie viewing across channels
3.9.2.3.Channel configuration
3.9.2.4.Image information
3.9.2.5.Annotation View
3.9.3.Magnification
3.9.3.1.Magnifying the whole image
3.9.3.2.Magnifying an area of the image
3.9.3.3.Scale bar
3.9.4.Viewing z-sections and timepoints
3.9.4.1.Automated viewing of z-sections and timepoints
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3.9.4.2.Selecting z-section and timepoints
3.9.4.3.Additional Movie Player options for z-section and timepoint viewing
3.9.5.Image Rendering options
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3.9.1. Viewing a specific Channel

The channel buttons (shown as the four coloured squares labelled 457, 528, 617, 685 in
Figure 3.9-1) enable you to turn on or off specific channels for multi-channel images.
Turning on or off a channel will result in an immediate visual change to the image shown in
the Image Viewer.

The colour band selected for a given channel corresponds to the emission wavelength of the
channel. If this information is not available, the channels will be mapped to red, green and
blue. The colour used to display any channel can be customised using the Colour Picker
(Section 3.9.2).

Channels can be turned on or off by clicking the relevant channel selection button, aligned
vertically on the left edge of the Image Viewer window. Buttons show the colour associated
with the channel, plus wavelength in nanometres (if this information is available).
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3.9.2. Additional viewing options

3.9.2.1.Colour and greyscale viewing
3.9.2.2.Movie viewing across channels
3.9.2.3.Channel configuration
3.9.2.4.Image information
3.9.2.5.Annotation View
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3.9.2.1. Colour and greyscale viewing

The top two Image Viewer toolbar buttons change appearance depending on the current
state of the image:

(alternative state is ) enable toggling between colour model and greyscale display:

• To switch from colour display to greyscale, select .

• To switch from greyscale to colour display, select .

NB

The above options can also be chosen by opening the Controls menu and selecting the Models option. This
allows you to choose between Colour and Greyscale options.
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3.9.2.2. Movie viewing across channels

(alternative state is ) enable viewing single-channel views of the image, as a movie:

1. To start the movie, select . This will display the image for a short period using each of

the currently selected channels in turn.
2. The movie runs on a loop, and will continue until you stop it. To stop the movie, select

. The image then reverts to its appearance before the movie started.

This option is available for the Image Viewer's Standard View and Annotation View modes.

Movie options for viewing z-sections and timepoints are described in Section 3.9.4.
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3.9.2.3. Channel configuration

The Colour Picker button allows you to configure the channel corresponding to a

specific channel button. To associate a specific channel with a channel button:

1. Click on the Colour Picker button.
2. In the menu that appears, choose which channel to adjust.
3. The Colour Picker window opens (Figure 3.9.2.3-1).
4. You can then select a colour in one of three ways, each available by selecting one of the

toolbar buttons at the top of the window. These options are:

a. Using the HSV colour wheel;
b. Using RGB colour sliders (shown in Figure 3.9.2.3-1);
c. Showing the colour list.

5. Once happy with your settings, select Accept to confirm the changes, or Revert to
ignore the setting changes you have just made.

6. You should now see the channel change applied to the relevant channel button.

Figure 3.9.2.3-1 Colour Picker Figure 3.9.2.3-2: Channel Info window

The Colour Picker can also be accessed by double-clicking on a channel button.

Right-clicking on a channel button gives access to a menu from which you can choose to
bring up the Colour Picker or to display additional information about the channel (Figure
3.9.2.3-2).
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3.9.2.4. Image information

To view basic information about an image displayed in the Image Viewer, select the Image
Info button : The Image details window then appears (see Figure 3.9.2.4-1).

Figure 2.9.2.4-1 : Image information window
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3.9.2.5. Annotation View

One advantage of the Annotation View mode of the Image Viewer is that it allows you to add
annotations to an image while looking at it in some detail (see Figure 3.9.2.5-1).

In this view, the Annotations panel is shown in a similar way to the Data Manager, showing
any existing annotations plus the name of the user who added the annotation and the date
they were added; like in Data Manager you can add annotations to the image as desired.

Note that the annotations exist as separate text attributes of the image - the image file itself is
not annotated.

Figure 3.9.2.5-1 : Image Viewer Annotation View
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3.9.3. Magnification

It is possible to view areas of the image in more (or less) detail by setting the magnification of
the image or by using the lens feature. This feature works for all three Image Viewer modes:
Standard View, Annotation View and Split View.

3.9.3.1.Magnifying the whole image
3.9.3.2.Magnifying an area of the image
3.9.3.3.Scale bar
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3.9.3.1. Magnifying the whole image

To magnify the whole image, use the Zoom feature:

1. Open the Zoom menu.
2. Choose from one of the predefined magnification levels.
3. The display of the Image Viewer will change to show the selected image (Figure

3.9.3.1-1).

This works in a similar fashion in Standard View, Annotation View and Split View modes.

For increased magnification, you may need to use the Image Viewer's scroll bars to view all
parts of the image; to avoid this, you can resize the Image Viewer window to show an
increased area of the image.

Figure 3.9.3.1-1 : Image Viewer showing magnified image
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3.9.3.2. Magnifying an area of the image

The Lens feature allows you to see an area of the image at a greater magnification level than
the Zoom feature. It also allows you to see the magnified section alongside the image as a
whole. It works in a similar fashion in Standard View, Annotation View, and Split view.

1. Open the Zoom window:

• Either select the Lens toolbar button:

• Or open the Controls menu and select the Lens option.

2. The Zoom window will now appear beside the Image Viewer window, and shows a
magnified area of the image.

Below the image is additional information on the dimensions of the magnified image. The
area of the magnified image is outlined in the main Image Viewer window (Figure
2_9_3_2-1).

To redefine the area of the image being magnified:

1. Click the mouse pointer on the highlighted area in the main Image Viewer.
2. Drag the highlighted area to the area of the image you wish to see magnified.
3. The Zoom window will be updated to reflect the change in area.

To change the size of the magnified area:

1. In the Zoom window, select the Lens menu.
2. Choose from one of the predefined window sizes.

NB

You may need to scroll or resize the Zoom Window to see all of the magnified area.

To change the magnification level:

1. In the Zoom window, select the Zoom menu.
2. Choose from the predefined list of magnification options.
3. The dimensions shown will be updated to reflect your choice.

To change the units of the dimensions shown in the Zoom Window, select the Units
menu and choose between microns and pixels . You can also zoom using the mouse
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wheel, if your operating system supports this.

Figure 3.9.3.2-1 Image Viewer and Zoom window
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3.9.3.3. Scale bar

The Image Viewer by default includes a scale bar in the bottom right corner of the image. In
Figure 3.9.3.1-1, the scale bar shows a length of 5 nanometres - the default setting. You can
configure how the scale bar is displayed, using the View menu.

To remove the scale bar from the current image display:

1. Select the View menu.
2. Select the Show Scale bar option.

To show the scale bar, repeat the steps above.

To change the length of the scale bar:

1. Select the View menu.
2. Select Scale bar length (in nanometres)
3. Then:

• Either choose a length from the options available,
• Or choose Custom , and in the pop-up window that appears, enter your preferred

length in the Value field and press Enter .

4. The scale bar length and label will now be adjusted.

To change the colour of the scale bar:

1. Select the View menu.
2. Select Scale bar colour option.
3. Choose from one of the colour options available.
4. The scale bar colour will now be adjusted.

NB

The scale bar will not appear if there is not enough space.
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3.9.4. Viewing z-sections and timepoints

For images with multiple z-sections and/or timepoints, the Image Viewer can allow manual or
automated viewing of each section. Z-sections and timepoints can be viewed separately or
together.

3.9.4.1.Automated viewing of z-sections and timepoints
3.9.4.2.Selecting z-section and timepoints
3.9.4.3.Additional Movie Player options for z-section and timepoint viewing
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3.9.4.1. Automated viewing of z-sections and timepoints

In Section 2.4.1.1, we outlined how the z-section or timepoint being viewed can be manually
configured, using the sliders provided by the Image Viewer.

You can also view each of the image's composite z-sections or timepoints as a movie. Each
z-section or timepoint is displayed in sequence for a short time period to form the movie.

Figure 3.9.4.1-1 : Movie Player

To play z-sections or timepoints as a movie:

1. In the Image Viewer window:

• Either select the Play Movie button: .

• Or open the Controls menu and select the Movie option.

2. The Movie Player window appears (Figure 3.9.4.1-1).
3. Select the Play button to play the movie.

4. Select the Stop button to stop the movie.

5. When a movie is playing, the Play button becomes a Pause button .

OMERO clients User Guide

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-74



3.9.4.2. Selecting z-section and timepoints

A third option for viewing different z-sections and timepoints exists when an image is shown
in Standard View and Annotation View. Holding down the mouse button and dragging the
mouse vertically up or down the image moves through z-sections; dragging horizontally
moves through timepoints. Dragging diagonally will simultaneously change z-sections and
timepoints.
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3.9.4.3. Additional Movie Player options for z-section and timepoint viewing

The Movie Player allows you to make additional adjustments to the movie being played.

To configure how the movie is played, the Play menu gives you several choices:

• Forward shows each z-section or timepoint in turn, once only.
• Backward shows each z-section or timepoint in turn, once only, but in the opposite order

to Forward .
• Loop shows each z-section or timepoint in turn Forward , but continuously until you

choose to stop the movie.
• Loop Backward shows each z-section or timepoint in turn Backward , but continuously

until you choose to stop the movie.
• Back and Forth shows each z-section or timepoint in turn, Forward and then

Backward , until you choose to stop.

Table 3.9.4.3-1 shows the difference in the Play options for an example image with 5
z-sections numbered 1, 2, 3, 4, 5.

Play option Frame order
Forward 1, 2, 3, 4, 5
Backward 5, 4, 3, 2, 1
Loop 1, 2, 3, 4, 5, 1, 2, 3, 4, 5, 1, 2...
Loop Backward 5, 4, 3, 2, 1, 5, 4, 3, 2, 1...
Back and forth 1, 2, 3, 4, 5, 4, 3, 2, 1, 2...

Table 3.9.4.3-1 : Movie Player Play options

To specify which sections or timepoints should be included in the movie:

1. Make sure the appropriate option is selected ( Across Z for z-sections only; Across T
for timepoints only, and Across Z and T to play a movie showing all z-sections for each
timepoint).

2. To specify which individual z-section or timepoint is respectively the first and last to be
shown in the movie sequence:

• Either move the left-hand slider button to select the first z-section (or timepoint) and
the right-hand slider button to select the last z-section (or timepoint);

• Or use the Start and End fields to type the number of the first z-section (or
timepoint) and last z-section (or timepoint).
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3.9.5. Image Rendering options

Options are also available to adjust rendering properties. Here, you adjust how the raw pixels'
intensity values are mapped to the image displayed on your monitor.

These are available by:

• Either selecting the Rendering Options toolbar button: .

• Or opening the Controls menu and selecting the Renderer option.

This brings up the Display Settings window (shown in Figure 3.9.5-1).

Figure 3.9.5-1 : Display Settings

Adjusting the rendering parameters will result in an immediate visual change to the image
shown in the Image Viewer, except when adjusting the values of the horizontal slider. By
default, the image shown in the Image Viewer will be updated when the knobs of the
horizontal slider are released. For an immediate update, check the Immediate Update check
box.
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The horizontal slider allows you to specify start and end values for the interval of the raw data
you wish to map. This is specified separately for each channel. Alternatively you can
manually enter values in the Start and End fields.

NB

Currently you can only select values between the displayed Min and Max values (0 and 2484 in Figure 3.9.5-1)

The vertical slider allows you to specify a range of the colour space i.e. a sub-interval of [0,
255]. This allows you to increase or decrease the overall brightness of the image.
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Figure 3.9.5-2 : Display Settings window showing advanced options

Advanced image rendering options are available by selecting the Show Advanced Options
button (Figure 3.9.5-2), This expands the Display Settings window to include options to:

• Select the mapping curve (from a choice of linear, polynomial, exponential or
logarithmic) for a channel.

• For polynomial or exponential curves, you can modify the shape of the curve for a
channel, by adjusting the gamma value.

• Adjust bit depth.
• Turn on or off noise reduction.
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NB

Bit depths and values for the vertical slider are the same across all channels; the other parameters are specified
for each channel.

NB

The Device Settings tab is not functional in the current version of OMERO.insight, but will in future versions
enable features such as reverse intensity and plane slicing.

Use the Save button to save rendering settings back to the database for future use.

Use the Undo All button to reset to the default rendering settings. Note that the default
rendering settings are not the ones previously saved but the internal defaults of the rendering
facility.
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3.10. Introduction to the Measurement Tool

The Measurement Tool significantly extends the functionality of the Image Viewer , by
allowing you to perform a variety of measurement tasks and analyses on your image.

These include:

• Defining Regions of Interest (ROIs) on the image - and on each z-section or timepoint of
multi-dimensional images;

• Annotating ROIs with textual annotations;
• Assigning stroke and fill colours to shapes;
• Getting measurements of the ROI shapes, including area, length and angle;
• Plotting intensity values;
• Loading existing ROIs and saving ROIs to file; and
• Managing ROIs - editing shapes, viewing, deleting and adding.

Figure 3.10-1 : Image Viewer with Measurement Tool

3.10.1.Accessing the Measurement Tool
3.10.2.The Measurement Tool interface
3.10.3.Creating ROIs
3.10.3.1.What is an ROI?
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3.10.3.2.Creating a single shape
3.10.3.3.Adding multiple ROI shapes on one plane
3.10.3.4.Creating an ROI across z-sections and timepoints
3.10.4.Saving and loading ROIs
3.10.4.1.Saving ROIs
3.10.4.2.Loading ROIs
3.10.5.Editing ROIs
3.10.5.1.Selecting ROIs
3.10.5.2.Annotation and labelling
3.10.5.2.1.Annotating an existing ROI shape
3.10.5.2.2.Labelling Images
3.10.5.3.Moving or resizing a single ROI
3.10.5.3.1.Moving a single ROI shape
3.10.5.3.2.Resizing a single ROI shape
3.10.5.4.Changing the appearance of an ROI shape
3.10.5.4.1.Adjusting display of annotation text
3.10.5.4.2.Adjusting display of the ROI shape
3.10.5.4.3.Hiding ROI shapes
3.10.5.5.Deleting a single ROI shape
3.10.5.6.Editing multiple ROI shapes and ROIs
3.10.6.Viewing ROI information
3.10.6.1.Viewing summary ROI information
3.10.6.2.Measurement results
3.10.6.2.1.Showing summary results
3.10.6.2.2.Refreshing summary data
3.10.6.2.3.Saving summary data
3.10.6.3.Viewing pixel intensity values
3.10.6.3.1.Graphical view
3.10.6.3.1.1.Configuring the Graph view
3.10.6.3.1.2.Saving graphical views
3.10.6.3.2.Intensity View
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3.10.1. Accessing the Measurement Tool

Assuming the image on which you wish to perform measurement is currently open in the
Image Viewer, you can open the Measurement Tool by one of two ways:

• Clicking on the measurement tool icon in the main Image Viewer toolbar above the

image; or
• Open the Controls menu, select Measurement .

This will launch the Measurement Tool (see Figure 3.10-1)
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3.10.2. The Measurement Tool interface

It is worth familiarising yourself with the Measurement Tool user interface, shown in Figure
3.10-1. It consists of two key areas - a series of buttons identified by icons, and below that a
series of tabbed navigation options. Additionally, there are menu options available at the top
of the application window, and in specific situations, available by right-clicking the mouse.

The Measurement Tool has a toolbar giving access to the key features of the tool, shown in
Figure 2: Figure 3.10.2-1

Figure 3.10.2-1 : Measurement Tool toolbar

Below this are a series of tabs giving access to key views of data relating to ROIs present in
the selected image (see Figure 3.10.2-2).

Figure 3.10.2-2 : Measurement Tool's tab navigation

In turn, these tabs give access to the following features of the Measurement Tool:

• Manager shows a hierarchical view of all ROIs and constituent shapes present in the
image. This allows you to select an individual ROI shape or ROI (a collection of shapes)
for analysis or editing.

• Inspector allows you to edit the appearance of an individual ROI shape, including colour
of line, fill and any text associated with the image.

• Results view shows a summary of key measurement data for all ROI shapes present. It
allows you to select an individual ROI shape for further detailed analysis.

• Graph Pane generates graphical representations - histogram and, for line ROI shapes,
line plots of intensity values, by channel, for the selected ROI shape. These can be
saved as images.

• Intensity View provides numerical data of individual pixel intensity values plus values
such as mean, maximum and minimum values, plus an option to export this data for
viewing in spreadsheet applications, such as Excel, as a CSV file.
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3.10.3. Creating ROIs

You can create Regions of Interest (ROIs) of varying types on a single plane, which can then
be expanded to become multi-dimensional.

3.10.3.1.What is an ROI?
3.10.3.2.Creating a single shape
3.10.3.3.Adding multiple ROI shapes on one plane
3.10.3.4.Creating an ROI across z-sections and timepoints
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3.10.3.1. What is an ROI?

In OMERO, we use the following definitions:

• ROI - a multi-dimensional object, consisting of one or more ROI shapes, indicated by the
icon: .

• ROI shape - a two dimensional object that appears on one plane only, indicated by the
icon: .

An ROI shape also automatically exists as an ROI. An ROI across multiple dimensions
(z-sections or timepoints) will be created when an individual ROI shape is selected and
propagated.

Propagating ROI shapes to create multi-dimensional ROIs is discussed more in Section
3.10.3.4. Viewing and managing ROIs and ROI shapes is discussed more in Section 3.10.5
and in Section 3.10.3.6.
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3.10.3.2. Creating a single shape

To create a single ROI shape on a single plane (z-section or timepoint) on an image, select
the appropriate toolbar shape option and draw the shape.

To draw a rectangle:

1. Select the Rectangle toolbar button: .

2. Hold down the mouse button on one corner of the area you wish to form the ROI, and
drag to the opposite corner.

3. Release the mouse button; the rectangle is now created.

To draw an ellipse:

1. Select the Ellipse toolbar button: .

2. Click on the edge of the area you wish to form the ROI, and drag the mouse pointer until
the circular shape approximates the ROI you wish to produce.

3. Release the mouse button; the ellipse is now created.

To draw a circular point (for example for counting spots):

1. Select the Point toolbar button: .

2. Click on the area of the image you wish to mark.
3. The point is now created (see Figure 3.10.3.2-1 for an example of multiple points drawn

on an image).

To draw a straight line:

1. Select the Line toolbar button: .

2. Move the mouse pointer to the area of the image at which you want to start drawing the
line.

3. Hold down the mouse button and drag the mouse pointer to the point you wish to finish
the line.

4. Release the mouse button; the line is now created. The length of the line will be shown,
along with the angle of the line to the horizontal (see Figure 3.10.3.2-2).

To draw a connecting line between two ROI shapes:

1. Select the Line toolbar button: .

2. Click inside or on the first ROI shape you wish to connect.
3. Click inside or on the second ROI shape you wish to connect.
4. A connecting line will be drawn between the two ROI shapes (see Figure 3.10.3.2-3).
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To draw a freehand line (scribble):

1. Select the Scribble toolbar button: .

2. Move the mouse pointer to the area of the image at which you want to start drawing the
line.

3. Hold down the mouse button and drag the mouse pointer to form the line.
4. Release the mouse button; the line is now created.

To draw a polygon:

1. Select the Polygon toolbar button: .

2. Move the mouse pointer to a point on the image at which you want to start drawing the
polygon.

3. Hold down the mouse button and drag the mouse pointer to create the polygon shape.
4. Release the mouse button; the polygon is now created.

Figure 3.10.3.2-1 : Point ROI
shapes

Figure 3.10.3.2-2 : Line ROI
shape showing

length and angle detail

Figure 3.10.3.2-3 : Elliptical
ROI shapes

and connector line
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3.10.3.3. Adding multiple ROI shapes on one plane

There is an option to allow to quickly add many ROI shapes of the same kind on the same
image plane:

• To move to multiple addition mode, open the Options menu, select ROI Creation , and
then select Create Multiple ROIs which allows you to add many ROI shapes.

• When you have finished adding shapes, click the Selection button to select an ROI

shape.
• To return to single addition mode, open the Options menu, select ROI Creation , and

then select Create Single ROI .

Alternatively, you can toggle between single and multiple addition mode by right clicking on
the ROI shape format button before adding a shape of that format. This will allow you to add
multiple ROI shapes of the selected format. To move from multiple addition mode to
Selection mode you will have to click the Selection button as above.
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3.10.3.4. Creating an ROI across z-sections and timepoints

ROI shapes, once drawn on a single plane, can be propagated (copied) across multiple
z-sections or timepoints to create a multi-dimensional ROI.

To propagate an ROI shape:

1. Select the ROI shape to be propagated.
2. Open the ROI Assistant by selecting the ROI Assistant button .

3. The ROI Assistant shows the timepoints and z-sections in which the selected ROI shape
currently appears with the symbol of the ROI shape's type (see Figure 3.10.3.4-1, which
shows an elliptical ROI shape).

4. Click on ROI shape symbol, and drag it across the z-sections or timepoints into which
you wish the shape to be copied.

5. Selected timepoints or z-sections will be highlighted (see Figure 3.10.3.4-2).
6. Make sure the Add ROI radio button is selected.
7. Select the Close button.
8. The ROI shape, and any accompanying information, including annotations (see Section

3.10.4), will now be propagated across the selected z-sections or timepoints.

The ROI Assistant can also be used to remove ROI shapes from selected z-sections or
timepoints, by following the instructions above, but selecting the Remove ROI checkbox.
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Figure 3.10.3.4-1 : Propagating ROI shapes (e.g. an elliptical ROI shape) with the ROI
Assistant
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Figure 3.10.3.4-2 : Propagating ROI shapes - selecting z-sections as propagation
destinations
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3.10.4. Saving and loading ROIs

ROI data need to be saved manually in order to be able to recall it in future. This is because
ROIs and associated date are saved separately to the image itself, and ROI information is
currently not saved automatically in OMERO.

3.10.4.1.Saving ROIs
3.10.4.2.Loading ROIs
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3.10.4.1. Saving ROIs

The following adjustments can be made to the ROI shape's annotation text:

• Select the Save button .

• Choose the location for the saved ROI file using the file browser window that appears.
• Select Save .

NB

If you try to close the Image Viewer with unsaved ROI information, a prompt will ask you whether or not you wish
to save this information.
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3.10.4.2. Loading ROIs

To view ROIs associated with an image:

1. Open the image in the Image Viewer.
2. ROIs associated with the image will be automatically loaded, so long as they were

created on the same computer used to view them.
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3.10.5. Editing ROIs

3.10.5.1.Selecting ROIs
3.10.5.2.Annotation and labelling
3.10.5.2.1.Annotating an existing ROI shape
3.10.5.2.2.Labelling Images
3.10.5.3.Moving or resizing a single ROI
3.10.5.3.1.Moving a single ROI shape
3.10.5.3.2.Resizing a single ROI shape
3.10.5.4.Changing the appearance of an ROI shape
3.10.5.4.1.Adjusting display of annotation text
3.10.5.4.2.Adjusting display of the ROI shape
3.10.5.4.3.Hiding ROI shapes
3.10.5.5.Deleting a single ROI shape
3.10.5.6.Editing multiple ROI shapes and ROIs
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3.10.5.1. Selecting ROIs

There are a number of ways to select one or more ROI shapes for editing.

Using the Image Viewer window:

• To select a single ROI shape on a single plane, click on the ROI shape in the Image
Viewer window.

• To select multiple ROI shapes on a single plane, right click on one ROI shapes, and
select Select All from the menu that appears.

• To select only ROI shapes of the same type, right click on one ROI shapes, and select
Select Same from the menu that appears.

Using the ROI Manager:

• Open the Manager view (see Figure 3.10.5.1-1), and select an ROI shape by clicking on
it.

• To select multiple ROI shapes, hold down the Shift key while clicking.

Figure 3.10.5.1-1 : ROI Manager window

For more on editing ROIs (groups of ROI shapes), see Section 3.10.5.6.
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3.10.5.2. Annotation and labelling

You can add a text annotation to an existing ROI shape; or label an area of the image directly
by adding a text ROI.

3.10.5.2.1.Annotating an existing ROI shape
3.10.5.2.2.Labelling Images
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3.10.5.2.1. Annotating an existing ROI shape

Separate to text ROIs, an existing ROI shape can be annotated in one of three ways:

1. Double-click on the shape; you can either edit the current annotation text or add new
ones;

2. Use the ROI Manager:

i. Open the ROI Manager.
ii. Select the shape to be annotated: the selected ROI shape will be highlighted.
iii. Type the annotation; the annotation will appear as you type in the Annotation

column.
iv. The annotation will appear within the ROI shape.

3. Use the ROI Inspector:

i. Select the shape to be annotated - the selected ROI shape will be highlighted.
ii. Open the ROI Inspector.
iii. Double click on the Annotation field.
iv. Edit the existing text, or add new texts.

See details of adjustments that can be made to the appearance of the annotation text in
Section 3.10.5.4.1
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3.10.5.2.2. Labelling Images

To add a text label ROI shape:

1. Select the Text toolbar button

2. Click on the area of the image in which the label is to be added.
3. A text box with the word 'text' will appear.
4. Double-click on the text box to add the desired label text.
5. The label is now shown - resizing the area of the text label will adjust the size of the text.

Note that the text label will exist as an ROI with a single shape, and appear as such in the
ROI Manager, Inspector and Results views. Double-clicking on the text ROI in the ROI
Manager and Inspector allows you to edit the text.
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3.10.5.3. Moving or resizing a single ROI

Once an ROI shape has been created, it is possible to move or resize it as required.

3.10.5.3.1.Moving a single ROI shape
3.10.5.3.2.Resizing a single ROI shape
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3.10.5.3.1. Moving a single ROI shape

To adjust the position of an ROI shape:

1. Select the Selection toolbar button: .

2. In the Image Viewer window, move the mouse pointer to a point inside the ROI shape
you wish to move.

3. Hold down the mouse button - the mouse pointer will change to the drag cursor.
4. Drag the shape to the desired location.
5. Release the mouse button.
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3.10.5.3.2. Resizing a single ROI shape

To adjust the shape of an ROI shape:

1. Select the Selection toolbar button: .

2. In the Image Viewer window, move the mouse pointer to the border of the ROI shape
you wish to move.

3. Hold down the mouse button - the mouse pointer will change to the resize cursor.
4. Adjust the ROI shape to the desired appearance.
5. Release the mouse button.

NB

For ROI shapes propagated across multiple z-sections or timepoints, resizing an ROI shape will only change the
shape on the one plane, not all z-sections or timepoints.
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3.10.5.4. Changing the appearance of an ROI shape

Various changes to the visual display of a selected ROI shape can be made through the ROI
Shape Inspector (see Figure 3.10.5.4-1).

Figure 3.10.5.4-1 : ROI shape Inspector view

To bring up the Inspector view adjust the appearance of an ROI shape:

1. Select the ROI shape, either by clicking on it in the Image Viewer window, or by
selecting it in the ROI Manager or ROI Results view.

2. Select the Inspector tab.
3. Current display settings for the ROI shape will be displayed.

3.10.5.4.1.Adjusting display of annotation text
3.10.5.4.2.Adjusting display of the ROI shape
3.10.5.4.3.Hiding ROI shapes
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3.10.5.4.1. Adjusting display of annotation text

The following adjustments can be made to the ROI shape's annotation text:

• Click the Show Text checkbox to turn on/off annotation text.
• Click the Show Measurements checkbox to turn on/off measurement text.
• Change the size of the annotation text by selecting the Font Size menu and selecting

the appropriate value.
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3.10.5.4.2. Adjusting display of the ROI shape

The following adjustments can be made to the appearance of the ROI shape itself:

• Change the width of the ROI shape's line by selecting the Line Width menu and
selecting the appropriate value.

• Change the colour of:

• the ROI shape's text;
• the ROI shape's fill (for polygonal ROI shapes);
• the ROI shape's boundary line;
• the ROI shape's measurement text.

To change a colour:

1. Double-click the appropriate coloured area in the Inspector window.
2. In the colour picker window that appears, select the appropriate colour from the options

displayed.
3. Adjustments can be made to the Alpha value by using the slider.
4. Select Accept to make the change.
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3.10.5.4.3. Hiding ROI shapes

To hide selected ROI shapes from display:

1. Open the ROI Manager (see Figure 3.10.5.1-1).
2. For the ROI shapes to be hidden, uncheck the Visible checkbox.

Repeating the above actions will make currently hidden ROI shapes visible again.
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3.10.5.5. Deleting a single ROI shape

To delete an individual ROI shape:

1. Select the shape to be deleted by clicking on the shape in the Image Viewer window (for
rectangles, ellipses and polygons, clicking inside the shape will select it).

2. Then

• Either press the Delete key on your keyboard to delete the selected shape;
• Or open the ROI Manager, right click on the selected ROI shape, select ROI

Management Options and then Delete .
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3.10.5.6. Editing multiple ROI shapes and ROIs

You can select whole ROIs, including all constituent ROI shapes, or selected ROI shapes for
editing:

1. Right-click on the ROI Manager.
2. Select ROI Management Options .

This gives access a menu that allows you a number of options:

• Duplicate the selected ROI or ROI shape. A copy of the selected ROI or ROI shape will
appear in the ROI Manager as a new ROI.

• Merge two selected ROIs (with constituent ROI shapes) into a single ROI.
• Split - removing selected ROI shapes from their parent ROI and putting them into a new

ROI.
• Propagate - propagating the selected ROI or ROI shape as described in.
• Delete the selected ROI or ROI shapes.
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3.10.6. Viewing ROI information

A range of information relating to the ROI shapes present in the selected image can be
viewed.

3.10.6.1.Viewing summary ROI information
3.10.6.2.Measurement results
3.10.6.2.1.Showing summary results
3.10.6.2.2.Refreshing summary data
3.10.6.2.3.Saving summary data
3.10.6.3.Viewing pixel intensity values
3.10.6.3.1.Graphical view
3.10.6.3.1.1.Configuring the Graph view
3.10.6.3.1.2.Saving graphical views
3.10.6.3.2.Intensity View
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3.10.6.1. Viewing summary ROI information

A summary information for all ROIs of an image can be revealed by clicking on the Manager
tab.

All ROIs and constituent ROI shapes are listed (see Figure 3.10.5.1-1).

• indicates an ROI.

• indicates an ROI shape.

For each ROI/ROI shape, the following essential information is shown:

• For ROIs, all constituent ROI shapes (this will be the case where an ROI shape has
been propagated across z and/or t to create a multi-dimensional ROI).

• The unique ID number of the ROI/ROI shape.
• For ROIs, the timepoints and/or z-sections across which it exists.
• The type of ROI shape (one of Rectangle, Ellipse, Point, Line, Connector, Polygon or

Text) is indicated by the appropriate symbol.
• Annotation text.
• Whether or not the ROI/ROI shape is currently visible.

To adjust the amount of data shown in the ROI Manager, the display can be adjusted in the
following ways:

• ROIs can be expanded to show constituent ROI shapes by clicking on the grey 'Expand'
arrow to the left of the ROI:

• To collapse an expanded ROI, select the grey 'Collapse' arrow:
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3.10.6.2. Measurement results

The ROI Results View shows summary measurement results for all ROIs and ROI shapes
(see Figure 3.10.6.2-1). It also allows you to configure which data should be included in any
results data file to be saved for exporting to other applications.

Figure 3.10.6.2-1 : Results view

3.10.6.2.1.Showing summary results
3.10.6.2.2.Refreshing summary data
3.10.6.2.3.Saving summary data

OMERO clients User Guide

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-113



3.10.6.2.1. Showing summary results

The data displayed by default in the Results view includes:

• Unique ID of the ROI shape;
• The T-section in which the ROI appears;
• The z-section in which the ROI appears;
• Type of ROI shape;
• Annotation text;
• The x and y co-ordinates of the centre of the ROI;
• The area of the ROI (if a rectangle, ellipse or polygon) in square microns or pixels

(depending on the units specified in the Options menu);
• The length of the ROI (if a line);
• The width and height of the ROI (if a rectangle, ellipse or polygon);
• The angle of the ROI from the horizontal (if a line).

In addition, it is possible to view:

• The length of the perimeter of the ROI (if a rectangle, ellipse or polygon);
• The x,y values for the start co-ordinates of the ROI;
• The x,y values for the end co-ordinates of the ROI;
• The x,y values for all constituent co-ordinates of the ROI.

The specific data values displayed in the Results view can be configured by selecting the
Results Wizard button (see Figure 3.10.6.2-1).

It may be necessary to use the scrollbar to reveal all columns of data; alternatively the
window can be resized to show all data.

Figure 3.10.6.2.1-1 : Results view
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3.10.6.2.2. Refreshing summary data

If any changes are made to the image's ROIs - for example by resizing them, adding new
ROI shapes or deleting existing ROI shapes, the data shown in the Results view will not be
displayed unless being refreshed through the Refresh button.
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3.10.6.2.3. Saving summary data

To save the currently displayed data:

• Select the Save button.
• Specify the location of the file to be saved.
• Choose the format for the saved data. At present this is limited to Comma Separated

Variable (CSV) format.
• Select Save .
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3.10.6.3. Viewing pixel intensity values

Pixel intensity values for an individual ROI shape can be viewed graphically or as figures in
tabular format.

3.10.6.3.1.Graphical view
3.10.6.3.1.1.Configuring the Graph view
3.10.6.3.1.2.Saving graphical views
3.10.6.3.2.Intensity View
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3.10.6.3.1. Graphical view

Selecting the Graph Pane tab shows intensity values as a histogram. Additionally, a line
profile will be shown for line ROI shapes (see Figure 3.10.6.3.1-1).

Figure 3.10.6.3.1-1 : Graph pane view of pixel intensities

If the ROI shape is moved or resized, or another ROI shape is chosen, the histogram and line
profile (if shown) will be automatically updated to reflect these changes.

3.10.6.3.1.1.Configuring the Graph view
3.10.6.3.1.2.Saving graphical views
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3.10.6.3.1.1. Configuring the Graph view

To change the magnification of the Graph view, right click on the histogram or line profile.
This brings up a menu that allows you to:

• Apply a 'zoom in' or 'zoom out' effect to the data by changing the visible values of the x
and/or y axes, increasing or reducing the range of values shown in the graph.

• Apply an automatic scaling effect so that the ranges of the x and y axes accommodate
exactly the maximum and minimum values of the intensity data of the ROI shape in
question.

If the selected ROI shape is part of a multidimensional ROI, slider bars will be provided to
allow you to move through each timepoint and/or z-section, in a similar way to the Image
View window. In the example shown in Figure 3.10.6.3.1-1, the vertical slider bar to the left of
the figure allows you to change the z-section for which the intensity data should be shown.

OMERO clients User Guide

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-120



3.10.6.3.1.2. Saving graphical views

The graphs shown can be saved as images:

• Right click on the graph to be saved.
• Select the Save as... option in the menu that appears.
• Choose the location of the image file to be saved.
• Select the Save button.
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3.10.6.3.2. Intensity View

Selecting the Intensity View tab shows intensity data for the selected ROI shape as a table of
values (Figure 3.10.6.3.2-1).

Figure 3.10.6.3.2-1 : Intensity view of pixel intensities

The Intensity View window shows intensity values for a selected channel. The selected
channel can be changed using the menu towards the top right of the window.

It also shows summary intensity data, to the right of the tabular display of intensities,
including:

• Minimum intensity value;
• Maximum intensity value;
• Mean intensity value;
• Sum of all intensity values;
• Standard deviation;
• X and Y co-ordinates of the ROI shape;
• Width and height of the ROI; and
• X and Y co-ordinates of the centre of the ROI shape.

If the ROI shape is moved or resized, or another ROI shape is chosen, the values will be
automatically updated in the Intensity View window.

If the selected ROI shape is part of a multidimensional ROI, menus will be provided to allow
you to move through each timepoint and/or z-section. In the example shown in Figure
3.10.6.3.2-1, the menu to the left of the figure allows you to change the z-section for which
the intensity data should be shown.
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Results shown in the Intensity View can be saved in a similar way to the Results view, by
selecting the Save button at the bottom right of the Intensity View window.
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3.11. The Hierarchy Viewer: viewing multiple images

For viewing a selection of images, the selection initially appears as a set of thumbnails in a
new window - the Hierarchy Viewer. What you see in the Hierarchy Viewer depends on what
you selected. Table 3.10-1 summarises how thumbnails are displayed in the Hierarchy
Viewer by default using the Hierarchical Layout option.

Selection Hierarchy Viewer shows...
One or more images individually selected All images in a flat view layout (see Figure

2.4.1-3)
One dataset or category All images in one container
Multiple datasets or categories Multiple thumbnail containers, one for each

datasetor category
One project or category group Multiple thumbnail containers, one for each

dataset in the project or category group
Multiple projects or category groups Multiple projects or category groups Multiple

thumbnail containers; one for each dataset in
each project/category group (see Figure
Figure 3.10-1)

Table 3.10-1 : Image selection method in Hierarchy Viewer display

The Hierarchy Viewer offers an alternative layout - Flat Layout option. This is a flat grid
display of all displayed thumbnails, with no containers.

To select your preferred layout option, open the View menu, select Layout and choose
between Flat and Hierarchical .
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Figure 3.10-1 : Hierarchy Viewer showing multiple containers

3.11.1.Viewing an image from the Hierarchy Viewer
3.11.2.Using the Hierarchy Viewer
3.11.2.1.Adjusting thumbnail display
3.11.2.2.Display Tree View of images
3.11.2.3.Sorting images
3.11.2.4.Managing images in the Hierarchy Viewer
3.11.2.5.Additional image information: the Working Area
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3.11.1. Viewing an image from the Hierarchy Viewer

Once you see thumbnails in the Hierarchy Viewer, you can view an individual image in more
detail in the Image Viewer through the following options:

1. Double-click on the image's thumbnail.
2. Select the image thumbnail and then select View from the Edit menu.
3. Right-click on the image thumbnail to display the Edit menu as for option 2.

The Image Viewer will then display the image as shown in Figure 2.4-1

OMERO clients User Guide

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-126



3.11.2. Using the Hierarchy Viewer

The Hierarchy Viewer has many additional features to allow access to information about the
current image selection.

3.11.2.1.Adjusting thumbnail display
3.11.2.2.Display Tree View of images
3.11.2.3.Sorting images
3.11.2.4.Managing images in the Hierarchy Viewer
3.11.2.5.Additional image information: the Working Area
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3.11.2.1. Adjusting thumbnail display

You can adjust the way the sets of thumbnails are displayed in the Hierarchy Viewer in a
number of ways:

Moving a container: Select the container and drag it with the mouse to wherever you wish
within the Hierarchy Viewer window.

Resizing a container: Click a corner of the container and drag the mouse to resize the
container.

NB

You cannot resize an image by dragging it, nor drag an image from one container to another.

Magnifying an individual thumbnail: To enlarge a single thumbnail:

1. Select the Magnify button .

2. Move the mouse pointer over the thumbnail to be magnified. An enlarged version
appears.

3. If you have a mouse wheel, you can increase or decrease the magnification factor by
scrolling the wheel.

Continuous movement of the mouse pointer will magnify in turn each image the pointer
passes over.

To keep a specific thumbnail on screen:

1. Select the pin-up icon .

2. The thumbnail will now remain on screen regardless of the position of the mouse pointer.

If you have a mouse wheel, you can increase or decrease the magnification factor of the
pinned thumbnail by scrolling the wheel.

To remove a pinned-up thumbnail:

1. Select the Close button at the top of the thumbnail window.
2. The pinned up thumbnail is removed from display.
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NB

Closing the Hierarchy Viewer window also removes all pinned-up thumbnails.

Change the size of all thumbnails in a container: You can enlarge or reduce the size of
each thumbnail in a selected container (this includes all thumbnails in sub-containers).

To increase the size of all thumbnails:

1. Select the container.
2. Select the Zoom In All Images... button .

To decrease the size of all thumbnails:

1. Select the container.
2. Select the Zoom Out All Images... button .

To reset the size of all thumbnails:

1. Select the container.
2. Select the Reset Thumbnail Size... button .

3. Thumbnails will return to the default size.

View one thumbnail at a time in a container: Click on the Switch to Single-view mode
button. The display changes to show only one thumbnail in the selected container.

To change the thumbnail currently in view:

1. Click the Switch to Single-view mode button again.
2. Choose the Select option from the menu appears.
3. Then select the filename of the image you wish to view from the submenu that appears.
4. The displayed thumbnail changes.

To return to viewing multiple thumbnails:

1. Click the Switch to Single-view mode button again.
2. Choose the Multi-view mode option from the menu that appears.
3. You will now see all thumbnails in the container.

Collapse a container: Click on the Collapse button at the top of the container you wish to
collapse. This will temporarily remove all thumbnails from view and reduce the size of the
container. Click on the same icon again (it is now an Expand button) to bring the thumbnails
back.
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3.11.2.2. Display Tree View of images

Selecting the Display Tree View option opens a pane where you can view the files

currently shown in the Hierarchy Viewer as a tree structure - much like the left-hand pane of
the Data Manager.

When the Tree View is visible, select the Display Tree View button again to remove this
pane.
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3.11.2.3. Sorting images

Like the Data Manager, images in the Hierarchy Viewer can be sorted within a set by date or
name (see Section 3.8.1).

- Alphabetical sort. Select this option to sort image file names in alphabetical order.

- Date sort. Select this option to sort image file names in order of the date they were

taken on the microscope - and if this information is not available, in order of the date of import
into OMERO.
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3.11.2.4. Managing images in the Hierarchy Viewer

In the Hierarchy Viewer, you can perform management actions on a single image or multiple
images:

• Categorise or decategorise an image or selection of images.
• View and edit annotations for an image or selection of images.
• View property information of an individual image.
• Remove an image from its current dataset.

To perform any of these tasks, you can:

• Select one or more images in a container, and then open the Edit menu to select the
operation of your choice.

• Or, right-click on a single image to see the Edit menu as above.

Icons are used to indicate the presence of category and annotations for any image appearing
as a thumbnail in the Hierarchy Viewer; this iconic information is preserved for pinned up
thumbnails.

Clicking on an icon will bring up the corresponding tab in the Working area (see Section
3.10.2.5)
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3.11.2.5. Additional image information: the Working Area

The Working Area is an area at the bottom of the Hierarchy Viewer window where detailed
information about the currently selected image is available. Any image with a thumbnail
shown in the Hierarchy Viewer can be selected by single-clicking or double-clicking the
image.

To show the Working Area (Figure 3.10.2.5-1):

1. Select the Working Area toolbar button to show the Working Area; when the

Working Area is visible, select this button again to hide it;
2. Use your mouse to drag the Working Area to the desired size.

Figure 3.10.2.5-1 : Hierarchy Viewer showing Working Area

The Working Area (illustrated in Figure 3.10.2.5-1) provides similar information to the
right-hand panel of the Data Manager. There are five tabs, each providing access to a
specific Working Area feature, and each described below.

1. Annotation: Selecting this tab views all current annotations for the selected image. You
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can add additional annotations or delete an annotation you have previously entered. For
more details see Section 3.6. This tab is selected if you click on the Annotation icon for
a thumbnail.

2. Categorisation: This enables you to see the categories the currently selected image
belongs to. You can then declassify the image's categorisation in a similar way to the
Data Manager (see Section 3.7). This tab is selected if you click on the Categorisation
icon for a thumbnail.

NB

To categorise an image or collection of images you need to use the Edit menu.

3. Find: This feature enables you to search within the selection of images shown in the
Hierarchy Viewer. The find works in a similar way to the Data Manager Find feature
(discussed in Section 2.8.2). Results are displayed in the Results panel to the right of
the Find form.

4. Editor: This enables you to view and edit Properties and Permissions information (see
Section 2.5 for more details).

5. Info: Shows additional information about the image, including:

a. Number of pixels along X and Y axes;
b. Number of z-sections;
c. Number of timepoints;
d. Size of a pixel in microns;
e. Emission wavelengths (if available).

The Working Area can be set to automatically show information for any thumbnail when the
mouse pointer hovers over that thumbnail. To enable this functionality, select the button.

To stop this behaviour, select the button again.
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3.12. Managing windows in OMERO.insight

As you work with images in OMERO.insight, you may end up with several open windows.
The Windows menu, available at all times, shows all windows you have currently open in
OMERO.insight, and allows you to jump between windows.
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3.13. Closing OMERO.insight

To end a session using OMERO.insight, open the File menu in the Data Manager and select
Quit the Application ; or, close the Data Manager window.

NB

Whenever you attempt to start a new action without saving edits or additions, you will be prompted to save or
cancel the changes you made.
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4. Feedback reporting

4.1.Help Information
4.2.Feedback Facility
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4.1. Help Information

Help information is not currently available through the Data Manager Help menu; but you can
send feedback by opening the Help menu and select Send Comment .
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4.2. Feedback Facility

This Beta version of OMERO.importer and OMERO.insight has been rigorously tested to
ensure it works as expected. Errors however may occur and a window will appear (Figure
4.2-1) inviting you to submit feedback about the error.

Providing this information is not required, but will help the development team identify and
overcome the cause of the error. Submitting your email address is optional, and if you do,
this information will only be used to contact you for more details about what you were doing
when the error occurred.

Figure 4.2-1 : Error feedback form
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5. Background information

This User Guide concentrates on providing a practical guide to managing, viewing and
manipulating image in OMERO, but the following information in this section gives a brief
outline of the principles and concepts used by OMERO.

5.1.What is OMERO?
5.2.The OMERO Environment: client and server
5.3.5-Dimensional images
5.4.The OMERO Data Model and Hierarchies
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5.1. What is OMERO?

OMERO is a set of software tools that supports image data management, visualisation and
annotation. OMERO tools include:

• an OMERO Server;
• and a series of client applications:

• OMERO.webadmin;
• OMERO.importer;
• OMERO.insight.
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5.2. The OMERO Environment: client and server

OMERO's design follows a standard client-server architecture. A single installation of an
OMERO server will usually be used for an entire laboratory or imaging facility. Image data
and metadata are typically stored on a central computer running the OMERO server, and
then accessed via a standard Ethernet network using OMERO client applications that run on
a user's workstation or laptop computer.

The OMERO Server manages all image metadata (date, size, channel names, etc.) but also
contains an image rendering facility that generates fully rendered images, ready for display in
an OMERO client application.
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5.3. 5-Dimensional images

OMERO allows handling of up to 5-dimensional images. As well as the conventional x and y
dimensions, you may store, view and manipulate z-sections, channels, and timepoints. The
relationship of these multiple dimensions is illustrated in Figure 5.3-1

Figure 5.3-1 : Multiple dimensional images

OMERO clients User Guide

Copyright © 2006-2007 University of Dundee. All Rights reserved.
Page-144



5.4. The OMERO Data Model and Hierarchies

All information in OMERO revolves around a data structure called the object hierarchy. An
understanding of this is core to efficient and effective use of OMERO. This hierarchy defines
three kinds of objects:

1. Projects
2. Datasets
3. Images

and an organisational structure for grouping these objects together. This structure is shown in
Figure 4.4-1

Figure 5.4-1 : OMERO Object hierarchy

At the top of the object hierarchy is the project. Projects represent a large, long-term
investigation, usually by either a single OMERO user or a small collection of users in the
same research group.

Each project contains a number of datasets. Projects and datasets form a many-to-many
relationship; a project can contain more than one dataset, and each dataset can belong to
more than one project. Most analysis routines are performed at the dataset level. This
provides both a convenient batch processing capability, and the ability to calculate aggregate
information about the contents of a dataset.

Each dataset contains a number of images. Like projects, images form a many-to-many
relationship with datasets. Images in OMERO are inherently multi-dimensional - they consist
of pixels across the usual three spatial dimensions, and can include multiple colour channels
and time series.
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